
Term and Condition of License Agreement

Millennium QuickCard. Copyright () 1995-1998 Millennium Company Limited. 

All Rights Reserved.

License Agreement

You should carefully read the following terms and conditions before using this software.    Your use of 
this software indicates your acceptance of this license agreement and warranty.

This is    legal agreement between you (either an individual or an entity) and Millennium Company 
Limited ("MILLENNIUM"). Use of this software constitutes acceptance of the terms of this agreement. 

For information on distributing the shareware evaluation version of QuickCard see the section titled 
"Shareware License" below.

Registered Version

Each registered copy QuickCard may be in "use" on    computer when it is loaded    into temporary 
memory (.. RAM) or installed into permanent    memory (.., hard disk, CD-ROM, or other storage 
device)    of that computer, subject to the following conditions:

 separate registered copy of QuickCard must be obtained for each computer on which QuickCard 
will be used, even if such use is only temporary.    This is not    "concurrent use" license.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.    Because of the various hardware and software 
environments into which QuickCard may be put, NO WARRANTY OF FITNESS FOR    PARTICULAR 
PURPOSE IS OFFERED.    Good data processing procedure dictates that any program be thoroughly 
tested with non-critical data before relying on it.    The user must assume the entire risk of using the 
program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT    
REPLACEMENT OR REFUND OF PURCHASE PRICE.



Shareware License

Evaluation and Registration

This is not free software.    You are hereby licensed to use the shareware evaluation version of    
Millennium QuickCard 2000 for evaluation purposes without    charge for    period of 30 days.    If you 
use this software after the 30 days evaluation period    registration fee is required, as described in the   
Millennium QuickCard 2000 help file.    Unregistered use of    Millennium QuickCard 2000 after the 30-
day evaluation period is in violation of Thailand and international copyright laws.

Some features are disabled during the trial use, this include the printing, and saving cards.    word 
“UNREGISTERED” will be shown in the About Box until it was registered.

You may be asked to registered again if you reinstall the Microsoft Windows, format the hard disk, or 
change to the new one. You can request for new register code as many times as you lost or uninstall 
the previous registration.

Distribution of    Millennium QuickCard 2000

You are hereby licensed to make as many copies of the shareware evaluation version of this software 
and documentation as you wish; give exact copies of the original shareware version to anyone; and 
distribute the shareware version of the software and documentation in its unmodified form via 
electronic means.    There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission.

This License is personal between you and Millennium. It is not transferable and any attempt by you to 
rent, lease, sublicense, assign or transfer any of the rights, duties or obligations hereunder is void.



Registration and Payment

How to Register
Please fill in the register form by click at the Register button. We reserve the right to register only to 
the valid name and address. After the form filled, please send the form, enclose with the payment,    to 
Millennium Co., Ltd. as stated in “ How to Contact Us”

The register fee is US$30 (thirty US dollars net).

How to Pay
The easiest way is using the credit card via Internet. The payment and register can be reached at the 
following secure page:

https://www.regnow.com/softsell/nph-softsell.cgi?item=1278-2.

Please visit http://www.winfiles.com for more information.

Another only way is sending    bank draft to the company.

How to Contact Us

home page:    http://www.geocities.com/SiliconValley/Lab/6126/

related site:    http://www.pi.co.th 

e-mail:    m2000@provision.co.th

fax: (0662) 541-4737

mail: Millennium Co., Ltd.
520 Narang building, 2nd floor,
Rachadapisek rd., Samsanenok,
Huaykwang, Bangkok
10310
Thailand



Hardware Requirement

Intel CPU from 486 up to Pentium II, or compatible.

Minimum 8MB RAM

Microsoft Windows 95 or Windows NT 4.0 or later.

Display resolution at least 640x480 and 256 colors or more.

At least 4MB of Harddisk free space,    plus 2MB for templates.

Mouse and keyboard.



Starting QuickCard

When installed, QuickCard will add    menu “Millennium Applications” in the Start menu of Windows 95.
You may click Start button, choose Programs,    Millennium Applications, QuickCard.

If you want to uninstall QuickCard, choose “Uninstall QuickCard” in the Millennium Applications menu.

Now you ready to know the QuickCard    window



The QuickCard window

QuickCard    window is the standard Microsoft Windows application as shown. 

Next you should know the drawing tools



The Drawing Tools

Before starting creation of new name card, you need to know how to use the drawing tools.

Drawing Tools

 Select:  Use this tool to select any objects on card. You can select one or more at    time. Hold down 
the Shift key to select additional objects or deselect from the selected. You can click on the card and 
drag to overlap the object you want to select. Details are in How to select objects.

Text:  Use this tool to create    text object. Click and drag to specify the    text boundary. Enter text in 
the box that appear after the mouse released, click anywhere out size the text box to finish editing. 
When you want to change any text, use select tool to select that text, click again to edit. You can press
Enter to split lines manually. Press Esc to cancel.

Picture:    Use to insert    picture into the card. Click and drag to specify the boundary. Click without 
drag to specify the left-top position or double click the tool button to insert    picture on the center of the
card. The open dialog box will be appeared for selecting the picture file to be inserted.

Line:    Use to draw    line. Click and drag to specify the beginning and ending. You can draw    
horizontal or vertical line easily by hold down the Shift key while dragging and releasing.

Rectangular:    Use to draw    rectangular shape. Click and drag to draw    shape. Hold down the Shift 
key if you want to draw    square.

Round Rectangular:    Use to draw    round rectangular shape. Click and drag to draw    shape. Hold 
down the Shift key if you want to draw    square.

Ellipse:    Use to draw an ellipse shape. Click and drag to draw    shape. Hold down the Shift key if you
want to draw    circle.

More on using these tools are described in    How to Edit



Creating Card from Template

The easiest way to create    name card is to choose from the templates. Those template will be 
displayed for selection if you installed them while setting up. The following is the template dialog box.

The templates will be group into three categories. Horizontal, vertical, and greeting card and others. 
You can see fifteen templates at    times. Use scroll bar on the right to scroll to another fifteen. Double 
click the one you like, that template will be loaded as    new card for editing. Edit each text and change 
the picture to your logo to finish your card. Press Del key or select “Edit” “Delete” menu to remove the 
selected text.

When finish, select “File” “Save” to save it. To print, select “File” “Print“.

If you want to create another card from another template, select “File” “New…”    to display the dialog 
box and select the new one. If you want    blank card click Cancel. To create    blank card click “New” 
button on the tool bar. 

You can create your own template and add into the “greeting card and others” tab. You will know how 
to in Adding and Removing templates.



Saving the changes

When you want to save, select “File” “Save” or click “Save” button on tool bar. If you want to save the 
current editing card to    new file, select “File” “Save As...”, enter file name and click OK. If you want to 
save as template, select Save as type    to “QuickCard    Template”.



Printing the card

When you want to print one page, click “Print” button on the tool bar or select “File” “Print…” then click 
OK. If you want more than one page, change the number of pages before clicking OK.

You can choose not to print full page by changing the option to “Partial” then you can specify how 
many cards you want, which rows and which columns you want to start printing.

On full page, the option “Copy by printer” is selected to send only one page to printer and command 
the printer to copy that page to the number you want. Anyway, if you can get only one page on your 
printer, deselect this option.

The “Print cutting marker” option is available to control whether you want cutting marker to be printed 
on your card. 

Setup button is available to select from which printer you want to print together with paper size you 
desired.



Closing QuickCard 

You can close the editing card by selecting “File” “Close”. If the card is changed, you will be asked to 
save,    discard or cancel. Click Yes to save, No to discard, Cancel to cancel.

After finish using QuickCard , close it by select “File” “Exit”. If some card is changed, you will be asked 
to save,    discard or cancel for each card.



File Operation

There are many file operation commands in the “File” menu.

New…    is used to create new card from templates. This will display template dialog 
box for you to select and create new card. Clicking “New” button on tool bar to
create blank card without displaying the dialog box.

Open... is used to open    file. The “Open” button on tool bar will perform the same 
action. You can select file location and file type of card to be opened. 
Selecting “Template” if you want to edit the template and select “QuickCard 
Version .x” to open the old version file. The file list will be change correspond 
to the types. Check    Preview to display that card in preview box.    Unchecked
it to disable preview.

Save is used to save changes into the file. For the newly created, there is    dialog 
box to specify the name to be saved. The “Save” button on tool bar will do the 
same. 

Save As.… is used to save into the new file. Select folder in which the file to be saved and
enter the file name. You can select file type to be saved, either QuickCard    
file or QuickCard    Template. If that file is exist in the folder    message 
“Replace Existing File” will be displayed. Answer Yes to override that file, No 
to cancel then you can change to the new name.

Close is used to close the current card. If there are some changes, you will be asked
to save it. Answer Yes to save, No to discard, or Cancel to deselect closing.



How to select objects

The following describe how to select objects 
Select one object. Click on the object to select it.    For the transparent rectangular    and 

ellipses. For selecting, you have to click on the outline. 
Multiple Selection. Hold down the Shift key and click each object you want to select. Click on 

the selected object will deselect it. 
Select more than one object at    time. You can click and drag on the card to select any objects

overlap in the area you drag to. Hold down the Shift key to select more or deselect 
some objects. If the object in the dragging area is already selected, they will be 
deselected, otherwise selected.

The underlying object may be difficult to be selected. Use the object list on the tool bar to select the 
one you want. That list will be described as type, position (left, top) and size (width, height), or text in 
the object, or picture file name.



How to Edit

You can edit the selected objects as the following:

Move lick and drag the selected object to move to the new position. The object 
outline will be shown while dragging. 

Format You can format the selected object by clicking the button on the format tool 
bar, change color by clicking on the color grid as follow:

Font  name and size can be changed to any font in your system from the 
drop down list. Style of text can be selected bold, italic, and underline. 
Alignment of text can be selected for left, center, right. Orientation of text 
from normal, up-side-down, bottom-to-top, or top-to-bottom.
Color  of line and background can be defined by left and right clicking 
respectively. Custom color can be defined by left or right clicking on the 
preview sample box.
Border line styles and background patterns    can be selected from the 
drawing properties panel. Background pattern included solid and clear 
can be used to format text background.

Placing Order For the overlapped objects, you can change the order to top or bottom by 
select “Edit” menu. Bring to top will make the selected objects on top of all 
others. Send to back will make the selected objects to bottom of all others. 
Bring up and send down will change order up or down one at    time.

Connect lines    ou can connect two lines together by selecting “Format” “Connect Line”. 
These lines must be close together on each end otherwise, they cannot be 
connected. You can connect    line to the corner of    rectangular as well.

You can use the “Format” menu to format the selected drawing object, depend on which one you 
selected.

Formatting Font

Formatting Text

Formatting Picture

Formatting Drawing



Font

Font Specify the text font. This is the standard Windows font dialog box.



 Text Format

To format the text other than font, double click the text or select “Format” “Text”. You can preview the 
result in the sample box.

Boundary  Left, top width, height of text.
Rotation     Rotate text to any degrees of normal orientation.
Line Spacing Percentage of line spacing to the normal.
Alignment    Align text to left, center, right.
Transparent Text background is transparent or not.
Color Text background color.



Picture Format

Formatting the picture is done by double click to the picture or select “Format” “Picture”.

Keep Aspect: When checked, another size will be scaled to keep the aspect of the picture.

Embed picture: Checked to embed picture in the QuickCard file. The file will be very large but 
can be moved to anywhere without the picture file.

Open Picture: Open another picture file. These files must be of types Windows bitmap 
(.BMP), Windows metafile (.WMF), TIFF (.TIF), Gif (.GIF), JPEG (.JPG,JPE), 
PNG (.PNG), Paintbrush (.PCX).



Drawing Format

You can format drawing    shape (lines, rectangular, ellipses) by double click the shape or select 
“Format” “Drawing”.

Foreground Color: To specify line color or    rectangular and ellipse’ border.

Background Color: To specify background color of rectangular and ellipse.

Line Width: To specify    borders’ line width.

Round Radius: To specify round rectangular radius.



Adding and Removing Template

You can easily add or remove templates    into / from template dialog box by adding or removing .QT2   
file type into / from the QuickCard    installed folder. Which file to be removed will be known by file 
name shown on the template list. The added templates will be place in the “Greeting card and others” 
tab. Delete the unwanted templates from the QuickCard    folder to remove them from the dialog box.

You can create your own templates and add into template dialog by saving them to QuickCard    folder 
and select the type of QuickCard    Template.



Page Setup

You can setup paper and card size by selecting “File” “Page Setup” After setting the paper and card 
size, you can save it to the list for next card’s further selection.

There are six standard sizes defined in the list, Two A4 and two Letter size paper, each for horizontal 
card and vertical card. There are two A4 labels, two columns by eight rows, and three columns by ten 
rows. These labels are available from Millennium Co., Ltd.

If you want to set your own card size and layout, follow these steps:

- Select the paper size, A4 or Letter, or enter your own width and height. Set the orientation 
against the paper selected in the printer setup.

- Enter the left and top margin of the first card on the paper.

- Enter the card width and height to the size you want.

- Enter the number of columns and rows of card on page.

- Enter the space between each column and each row.

You can preview the layout after changing on each value.

For the colored paper you can set the color by clicking at “Color…” button. This color is only for 
designation and will not affect the printing.

If you want to save the layout for the next use, click “Save as...” button, enter the name for the layout 
then click OK. Next time you will see this name in the list of paper. If you save the existing name, it will 
be overridden with the new setting.



Guide Lines

There are two guide lines, horizontal and vertical. These lines are used to help on aligning the objects. 
You can drag the guide line from the top edge and the left edge and place it anywhere. When you drag
objects, you can align it to the line. There is    menu called “Align to...” in the “Format” menu. It will 
show the align dialog box that allow you to align the selected object to grid or guide lines. There are 

four buttons on tool bar  you can use to align objects rapidly to the guide lines by top, 
bottom, left, or right.

The align object dialog box allows you to align the object only horizontally, vertically, or both to grid or 
guide. You can set that alignment to move the object or to size them by selecting the option “Keep 
object size” or “Keep opposite side”.



Paper Background

If you use the pre-printed paper, you can insert paper pattern as    background for visual guide. This 
background may scanned in as    picture or draw your own in QuickCard. After insert the picture or 
draw some drawing, select them then select menu “Edit”, “Send to background”. Those objects will be 
shown but neither be selected nor printed.

If you want to view without background, select menu “View” “Background”. Selecting again to redisplay
it. If you want to change the background, cancel it by selecting menu “Edit”, “Cancel background”. 
Those objects will become normal objects that you can move, size, format, or delete.



Applying QuickCard 

 You can use QuickCard    to create any cards other than name card. Set up the card to any size and 
apply it to be    greeting card, invitation card, header or footer, brochure, certificate, menu or any 
document you want.

There are templates and samples of greeting for QuickCard. Two templates or two samples for each 
card, one for outside, the other for inside. The following will guide you to setting QuickCard for some 
kind of cards.

Greeting and Invitation Cards

Greeting card may be    card or    folder, anyway there are two sides, make two card and print one for 
each side. You can see in the following examples as    guide for your cards. 

Ex. Card of 4.5" by 6.0".    Set paper as A4 or Letter, orientation is landscape, and set card
width to 4.5, set card height to 6.0. Two columns and one row on each page.

Ex. Folder of 4.5" by 6.0" vertical. Set as above example but the card width is 9.0 and 
there is only one column.

Ex. Folder    4.5" by 6.0" horizontal. Set paper as A4 or Letter, orientation is portrait, and 
set card width to 4.5, set card height to 12.0. One column and one row on each page.

Heading or Footing

You can use QuickCard    to create heading or footing of paper easier than any Word Processor. Set 
paper size as the one you use, A4, Letter, or Legal. Set card width and height to the area you want for 
header or footer. Set the number of column and the number of row to one. For footing set top margin 
to position the area at the end of the paper.

Ex. Heading on Letter size paper, one inch high, half inch from any side. Select Letter 
paper, left and top margin is 0.5. Card width is 7.5 inches and card height is one inch 
There is only one row and one column on page.

Ex. Footing, Letter size paper, four inches wide, half inch high, center at the bottom, half 
inch form edge. Set card width and height to 4.0 and 0.5 Left margin is 2.25, top 
margin is 10 inches. One column and one row. 

Brochure, Certificate, Menu, or any document

Set up the card as full page, for example, card size is 7.5 by 10 inches, one row, one column, both 
margin are 0.5. Fill the area with border clipart or one for each corner. You may insert background 
texture for printing or draw    shape with any color you want. Draw text anywhere you like, format them 
any color.



Customizing View

By default, QuickCard will show all toolbars, panels, guide, grid, rulers, status bar. You can customize 
this view by select    menu in “View”

Tool bar:      File, print, edit, tools, zoom, and drawing object list are on this bar. This menu 
will toggle the visibility of this bar.

Status bar:        Cursor position, percentage of view, progress of picture loading, and hint are 
on this bar. This menu will toggle the visibility of this bar.

Format Text:    Text font, text alignment, and object alignment are on this bar. This menu will 
toggle the visibility of this bar.

Format Drawing: Line style and background pattern are on this panel. This menu will 
toggle the visibility of this panel.

Color grid:    Color preview and grid are on this bar. This menu will toggle the visibility of 
this bar.

Horizontal ruler: Show or hide the horizontal ruler.

Vertical ruler: Show or hide the vertical ruler.

Guide Lines: Show or hide the guide lines.

Grid:          Show or hide the grid.

Background: Show or hide the background objects.

Zoom:                  Select percentage of display to actual size.



Options

Select “Edit” “Options” to display the options dialog box.

Operating Options    

Optimize picture for optimize palette on 256 colors display. This might take    long time but the 
picture will be displayed in correct color. Unchecked it if picture loading is too slow.

Dither the picture on 256 color. For better display of photos on 256 colors display. Unchecked 
it for graphical picture that may be too grainy.

Automatically resize text boundary. Get better text boundary when you manually wrap 
lines.

Automatic word wrap. Text will be wrapped automatically when wider than boundary. No 
sizing.

Double time for double click. Twice the double click time before enter text editing.

Use QuickAlbum to insert picture. QuickAlbum can help you select    picture by creating 
thumbnail of your choices by drag and drop. It may be too difficult for novice. Check 
this option to use QuickAlbum as default for every time opening picture dialog box.

Startup Options    Affect one the next start up only.

Save last setting on exit. The window layout, view options, tool bar positions, last open 
and save folder, will be saved before exit.

Show templates on start up. Check to enable QuickCard to show template dialog box on 
start up.

 



QuickAlbum

QuickAlbum is an alternative picture opening. Additional feature is creating picture thumbnails. You 
can insert picture to    thumbnails by selecting picture file from    folder. one folder is one catalog. 
Changing to another folder means    changing to another catalog.

You should select only files you really want to insert into thumbnails. The number of thumbnails are 
limited for each catalog which totally must not exceed one thousand. One cluster of disk space will be 
consumed for each thumbnail. It may be run out easily.

To create    thumbnail, drag file name from the file list to an empty block. You can insert all files 
contained in    folder into thumbnail by clicking “Add All” button. Remove the unwanted thumbnail by 
select it and click “Remove” or press Del key. When you want to insert    picture from thumbnail into the
card, select that thumbnail and click OK or double click on it. You can even insert    file from the file list 
without creating      thumbnail. You can preview picture by checking the preview box.



QuickPreview

QuickPreview is another application in the QuickCard. It allows you to preview the pictures as 
thumbnails without creating any thumbnails. This function is easy to use, take no disk space, but 
working slowly because original large picture must be read every time picture preview is displayed. 
Due to you can not insert picture directly in to Quickcard, so, file name have to be recognized for 
selecting by normal open dialog box or QuickAlbum in QuickCard.

The print button is used to print any pictures seen on screen, .. one picture at actual size or fit the 
page, or thumbnails of any size you selected.




